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Notice Date: 2014-06-12 

 
 
This file lists all changes made to ETABS since the previous version. Most changes do not affect most users. 

Incidents marked with an asterisk (*) in the first column of the tables below are more significant and are included in the 
ReadMe file. 

Changes from v13.1.4 (2014-04-17) 

 

Analysis 
Enhancements Implemented 

* Incident Description 

* 64466 The iteration algorithm for nonlinear direct-integration time-history analysis has been enhanced to 
improve the rate of convergence and to reduce the time of analysis for certain models. Models run 
in the new version should produce the same results as in the previous version, subject to minor 
variations approximately within the convergence tolerance. Larger differences may be observed for 
ill-conditioned or sensitive models, but in such cases the new results should generally be better. 

Database Tables 
Enhancements Implemented 

* Incident Description 

 65374 
65636 

An enhancement was implemented adding a new database table, Group Assignments, that provides 
data indicating which objects are contained in the user-defined groups. 

Frame Design 
Enhancements Implemented 

* Incident Description 

 64173 For concrete frame design using the ACI 318-08 and ACI 318-11 codes, the design report for 
"Shear Details" has been enhanced for "Sway Special" frames by adding the field Design Shear 
(Vu) for clarity. Previously, only the factored Vu was reported, which may not be the governing 
force for capacity design. 

Results Display and Output 
Enhancements Implemented 

* Incident Description 

 66291 Minor changes have been made to the units: (1) The name of the mass-moment of inertia (MMI) 
units in the metric systems (SI and MKS) have been changed from N-m/s^2 to Kg-m^2, and from 
kN-m/s^2 to ton-m^2. This is a change in the name only. Numerical values are not affected.  (2) A 
new unit type has been added for modulus of elasticity and shear modulus. Previously the stress 
units were used for these quantities. These separate unit types allow for more control of formatting 
output given that the stress and moduli values may differ by several orders of magnitude. 
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User Interface and Display 
Incidents Resolved 

* Incident Description 

 63785 An incident was resolved where the command Help > About ETABS did not always show the name 
of the user or company in the field "This product is licensed to". No results were affected. If the 
software was "Run As Administrator", these names would show properly. 

 63861 An incident was resolved where the Frame Information form (by right-clicking on the frame 
member) would in some cases give a warning message when no error was present. This happened 
when two loads acting in different directions were at the same location on the frame. This was a 
reporting issue in the form only and results were not unaffected. 

 65795 An incident was resolved where the reported length of a link object was not always updated when 
the link geometry was modified by moving the end joints. This was a reporting issue only and did 
not affect any results. 

Graphics and Drafting 
Incidents Resolved 

* Incident Description 

 53984 An incident was resolved in which the rendered view did not always show the slab objects clearly at 
their correct vertical location. This was a graphical issue only and did not affect results. 

 56776 
59149 
59983 
63317 
63905 

An incident was resolved where the cross section of certain frame sections was not always drawn 
with the correct shape or with the correct orientation of the local axes. This could affect the 
extruded view, the rendered view, and the shape of columns in a plan view. This was a display issue 
only and no results were affected. The display of local axes using arrows (red-green-blue) was 
correct. 

 59562 
59676 

An incident was resolved where objects drawn on a reference plane were not visible when reference 
plane was activated. 

 59987 An incident was resolved for Section Designer (SD) sections where cross-section view of the SD 
section as shown in the model window was not always updated after the SD section was modified 
until after the analysis was run. This was just a display issue and results were not affected. The 
modified section was correctly used for analysis and design. 

 59992 An incident was resolved where, in certain rare cases, using the Perspective Toggle tool button 
could cause graphical display issues where shell objects were incorrectly shown to be overlapping. 

 60743 An incident was resolved in which the dots indicating frame releases were not being shown when 
using the File > Print Graphics command. This was a printing issue only. 

 66046 An incident was resolved where the View > Set Building View Limits command would not always 
work correctly when a story range was selected in a multi-tower model. No results were affected. 

 66142 An incident was resolved where some frame objects were not displaying in the 64-bit version of the 
software. This usually happened when section properties or some other text was being displayed on 
the frame. 

Modeling 
Incidents Resolved 

* Incident Description 

 57484 An incident was resolved where floor area objects would not replicate correctly when using the 
Story replicate option. This usually happened when the original area object was imported from 
Revit. 

Section Designer 
Incidents Resolved 

* Incident Description 

 61069 
62720 

An incident was resolved where the command Define > Section Properties > Frame Sections > Add 
Copy of Property, when applied to a Section Designer (SD) section, was linking the original and the 
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* Incident Description 

65789 new SD sections, such that changes to one section affected the other. Results were consistent with 
the model where the affected sections had the same properties. 

Loading 
Incidents Resolved 

* Incident Description 

 53027 
57082 
65668 

An incident was resolved in which the zip-code, latitude/longitude, and/or island information was 
not available when defining ASCE 7-05, ASCE 7-10, and NTC-08 response-spectrum functions or 
auto-seismic load patterns in the 64-bit version of ETABS. When this occurred an error message 
was generated. It was still possible to specify seismic coefficients directly without the use of the 
geographic database information. The 32-bit version was not affected by this issue. 

 60623 An incident was resolved where the self-weight of layered shells was also counting the weight of 
layers with "plate" only behavior. This should have been ignored and only layers with "membrane" 
or "shell" behavior should contribute to the self-weight. 

 63863 An incident was resolved where right-clicking on a frame member and editing one of its point loads 
in the Loads tab of the Frame Information form deleted all the other point loads on the member 
assigned under the same load pattern instead of updating just the one which was edited. 

* 64868 An Incident was resolved for NBCC 2010 auto seismic load case where maximum base shear 
according to section 4.1.8.11(2)(c) was being enforced for Site Class F with Rd > 1.5, for which 
case it is not applicable. Models with Site Class F with Rd > 1.5 should be re-run using the new 
version, since the previous results could be unconservative. 

Analysis 
Incidents Resolved 

* Incident Description 

 63522 An incident was resolved where the torsional section property J was not being correctly calculated 
for double-angle frame section properties. The value for J was reported as "NaN", and was 
effectively treated as zero torsional stiffness. This had insignificant effect on the analysis and design 
results for practical structures. However, the analysis .LOG file would sometimes report zero 
stiffness for the corresponding degrees of freedom or report an instability, depending on the solver 
used. The results were still valid for the structure having zero torsional stiffness in the affected 
members. In addition, steel frame design using the Eurocode 3-2005, Italian NTC 2008 and IS 
800:2007 codes were unable to report design results for the affected members. No other codes were 
affected. 

 63709 An incident was resolved for the link/support object of type T/C Friction Isolator (double-acting 
friction-pendulum isolator) where the nonlinear iteration could have difficulty converging during 
the analysis of nonlinear static or nonlinear direct-integration time-history load cases when a non-
zero gap opening was specified for the link property. When the convergence failed, results were 
unavailable. Otherwise the results would be accurate to within the convergence tolerance unless the 
model was ill-conditioned. 

 63907 An incident was resolved where the self-mass of composite column sections defined either directly 
or through the Section Designer may not have been computed correctly. This affected the mass 
computations slightly when the mass source specified included self-mass. When the mass source 
was specified from loads (self-weight) the mass computations were correct. The self-weight 
calculations were not affected, only mass. 

* 65561 
65822 

An incident was resolved where the directional combination of type CQC3 for response-spectrum 
load cases was not being correctly applied. The effect of this could be unconservative in some 
instances. Load cases using CQC3 should be re-run for confirmation. In addition, the default 
response-spectrum directional-combination type has been changed to SRSS, which was also the 
ETABS v9 default. Note that using directional combination of types CQC3 and SRSS will produce 
identical results when equal spectra are applied in both horizontal directions. 
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* Incident Description 

 65568 An incident was resolved where the initial stiffness used for iteration on multi-linear links (elastic 
and plastic) during nonlinear static and nonlinear direct-integration time-history analyses was taken 
to be zero. This could affect the rate of convergence for these types of analyses at the first load or 
time step, but did not affect the results to within the convergence tolerance. This is because the 
initial stiffness is used only for performing iteration, not for determining the actual force-
deformation behavior of these elements. Nonlinear modal time-history (FNA) analysis was not 
affected. 

Frame Design 
Incidents Resolved 

* Incident Description 

 59142 Documentation for all composite beam design codes have been updated to now specifically state 
that the metal deck braces the steel beams at both construction and service loads irrespective of 
whether the deck is filled or not. This is now consistent with the actual design behavior in ETABS 
since version 13.0.0. Previously the manuals stated incorrectly that the construction case was 
assumed to be unbraced. No results have changed. 

 59579 An incident was resolved for composite beam design using the AISC 360-10 and AISC 360-codes 
that corrects some display issues in the report for beam vibration due to rhythmic excitation:  (1) 
The entire table was being repeated twice,  (2) Some of the fields were not being filled.  (3) The 
value of wp was reported incorrectly.  (4) The activity type was not being reported. 

* 59598 
61171 
65965 

An incident was resolved for steel frame design using the AISC 360-10 code that addresses several 
issues for designing RBS beams:   
(1) The RBS hinge locations were not being correctly enforced.   
(2) The RBS capacity was always including the Ry factor, which is only applicable for load 
combinations involving seismic load. Now the design checks for the presence of seismic load and 
modifies the capacity accordingly.   
(3) The joint design was using the incorrect gravity shear from the RBS beam. Generally, 
however, the shear due to gravity is insignificant compared to capacity shear for RBS.   
(4) Right-clicking on the RBS beam to display Design Details was changing the Design Details in 
some models.   
(5) An explicit table for “RBS Properties” is now available in the Design Details for RBS sections. 

* 59825 
66941 

An incident was resolved where the concrete column check for PMM may not be correct. This 
error affected models that may at one time have been imported from text file (.e2k or .$et) and the 
column rebar was set to be checked instead of being designed. These models should be rerun and 
redesigned. 

 60622 An incident was resolved for concrete frame design and shear wall design per the ACI 318-11 
code, and steel frame design per the AISC 360-10 code, where certain redundant code-based load 
combinations were being created when wind and earthquake loads were specified along with the 
dead and live loads. The extra combinations were 1.2D +/- 0.5W and (1.2+0.2*Sds)D +/- 1.0E. 
These redundant load combinations would rarely govern design, but if they did the effect would 
have been conservative. These combinations are no longer generated. 

 62312 An incident was resolved for Italian NTC 2008 steel design code where Super Dead load factor 
used in default design combinations was 1.3 instead of 1.5. 

 62389 An incident was resolved in composite beam design using the Chinese 2010 code in which the 
design results were changed depending on whether it was run before or after steel frame design. 
This was an initialization problem and only affected the Chinese composite beam design code. 

 62516 An incident was resolved for steel frame design per the "AISC 360-10" code where any error 
messages for seismic design were referring to ANSI/AISC 341-05 section (clause) 
numbers instead of ANSI/AISC 341-10 section numbers. However, all calculations and results 
were correct. 
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* Incident Description 

 63086 An incident was resolved for steel frame design using the AS 4100-1998 and NZS 3404-1997 
codes where the governing equation for bi-axial bending was considered even when the moment in 
the minor direction was zero. Additional checks have been added for selecting the appropriate 
governing equation in such cases. This could be over-conservative and thus did not affect the 
acceptability of any section. Because of this change, results for Verification Examples 2 and 3 for 
each of these two codes have changed correspondingly. 

 63255 An incident was resolved for steel frame design and composite column design where the lateral 
bracing assignment was always using relative distances even when absolute distances were 
specified using the command Design > Steel Frame Design > Lateral Bracing > User Specified > 
Point or Uniform, or the command Design > Composite Column Design > Lateral Bracing > User 
Specified > Point or Uniform. Absolute distances specified as greater than unity had no effect, 
which tended to be conservative. The affected codes were the “AISC 360-05”, “AISC 360-10”, 
"AS 4100-1998", "CSA S16-09", "CAN/CSA-S16-01", "Eurocode 3-2005", "Italian NTC 2008", 
"IS 800:2007", and "NZS 3404:1997" codes for steel frame design and the "AISC 360-10" code 
for composite column design. 

 63309 An incident was resolved for concrete frame design using the AS 3600-09 code where the 
computed longitudinal reinforcement was sometimes too large due to an error in computing 
theta_v, i.e., the angle between the axis of the concrete compression strut and the longitudinal axis 
of the member. This error only affected beams over 250mm depth and where torsional 
reinforcement was required. 

 65175 An enhancement has been made to composite beam design where a warning message is now 
reported when user specified maximum/minimum depth limits are not satisfied. 

 65219 An incident was resolved for concrete frame design using the Indian IS 456:2000 code where the 
tabular output for "Additional Moment (IS 39.7.1)" in the "Flexural Details" tab was incorrectly 
converting for units and displaying the "Length Factor", "Section Depth", "KL/Depth Ratio", and 
"KL/Depth Limit" values as if they were moments, whereas they all should be treated as 
dimensionless ratios except for "SectionDepth", which should be treated as length. This was only a 
reporting issue and design results were not affected. 

 65468 An incident was resolved in composite beam design reporting in which the beam design 
inadequacy messages included the extraneous phrase “Deflection Design” in front of every 
message. This was not intentional, and all calculated results were correct and unaffected.  

 66011 An incident was resolved for ACI 318-08 concrete frame design where “Rebar Ratio %” and 
“Capacity Ratio” were reported incorrectly when "reinforcing is to be checked" is selected in 
concrete frame column definition. This was just a reporting error and no design results were 
affected. 

 65498 An incident was resolved for AS 3600-09 concrete frame design where "Shear Details" for 

columns sometime showed large values for φVus and φVn when AS 3600-09 Section 8.2.9 
governed. This was just a reporting error and no design results were affected. 

Composite Beam Design 
Incidents Resolved 

* Incident Description 

 57227 An incident was resolved for composite beam design using the AISC 360-10 and AISC 360-05 
codes that corrects some display issues in the report for beam vibration due to rhythmic 
excitation:  (1) The entire table was being repeated twice,  (2) Some of the fields were not being 
filled.  (3) The value of wp was reported incorrectly.  (4) The activity type was not being reported. 

Shear Wall Design 
Incidents Resolved 

* Incident Description 

 53631 An incident was resolved where the Pier label was previously allowed to be assigned to ramps, even 
though it only has meaning for the shear wall design of vertical walls. Now the Pier label can only 
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* Incident Description 

be assigned to vertical walls. 

 59989 
58996 
60391 

An incident was resolved for Eurocode 2-2004 shear wall design where the flag for “Second order 
effect” when set to "No" was not being enforced. This always produced a more conservative design. 
Only v13.1.3 was affected. 

* 60276 An incident was resolved where the shear-wall PMM design was always using the first rebar 
material defined instead of using the one specified using the Wall preferences. Any models where 
there were more than one material defined of type rebar and any other than the first one of these was 
used in the wall preferences should be re-run and re-designed.  

* 61074 An incident was resolved where the shear design of shear walls with more than one leg may be 
incorrect. Each leg was designed for forces that applied to the full 3D shear wall. This would 
normally over-design the shear wall. This error affected only those models which had multi-step 
cases used in design combinations. 

 61155 An incident was resolved for shear wall design where the interaction diagram shown in the 
interactive report was displaying an incorrect caption instead of pier section name. This was only a 
display issue and no results were affected. 

 65637 An incident was resolved for shear wall design using the CP 65:1999 code where the design did not 
run for some models. When this occurred, design results were not available. When the design ran as 
expected, results were not affected. 

 66253 An incident was resolved for shear wall design where the design was not able to generate the 
necessary interaction diagrams for the Section Designer sections in certain cases. When this 
occurred, results were not available. 

Results Display and Output 
Incidents Resolved 

* Incident Description 

 59763 An incident was resolved for NBCC 2005 and NBCC 2010 auto seismic load calculations where the 
time period used was not reported correctly. This was just a reporting issue and analysis results 
were unaffected. 

 60342 An incident was resolved in which the printout from the Print Graphics command would indicate 
units that were not consistent with the numerical values displayed on the graphic. The numerical 
values were correct in the current display units used in the model windows. 

 61953 An incident was resolved for auto-seismic load patterns using NBCC 2005 and NBCC 2010 codes 
where the time period for Method A was incorrectly reported. This was only a reporting issue and 
did not affect results. 

 62160 An incident was resolved that addressed two issues for automated wind loading:  (1) The calculation 
sheets for ASCE 7-02, ASCE 7-05, and ASCE 7-10 wind loading incorrectly reported the values for 
diaphragm eccentricities e1 and e2. This was a reporting issue only and did not affect the actual 
loading.  (2) The form for command Display > Load Assigns > Frame provided the option to show 
open structure wind loading even when it wasn't applicable to the chosen load pattern. No results 
were affected. 

 62535 An incident was resolved where the joint reaction values shown in the model window by right-
clicking on the joint or by hovering over the joint with the mouse were sometimes incorrect. This 
happened rarely and only in some views. This was a display issue only and the tabulated results 
were correct. 

 64126 An incident was resolved in which the approximate period (Ta) value was incorrect in the report 
calculation sheets for ASCE 7. This was a reporting issue only. The results were not affected. 

 65012 An incident was resolved where the tables shown using the command Display > Response-
Spectrum Curves > Show Table were sometimes given in the incorrect units. When this occurred, 
the error was obvious because the tabulated values did not agree with the plotted values. The 
affected curves and tables are for the response-spectrum curves computed from the time-history 
response at a joint, and not the response-spectrum functions used as input to a response-spectrum 
load case. In addition, plots shown using command Display > Response-Spectrum Curves have 
been modified to now use unformatted values instead of formatted values because formatted values 
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* Incident Description 

sometimes made the same plot appear different for different choices of units and/or formatting. 

 65225 An incident was resolved for the ASCE 7-02 wind loading calculation report in which it indicated 
wind exposure D when the load pattern was defined as exposure C. This was a reporting issue only 
and results were not affected. 

 65484 An incident was resolved in which the report was not created if it included wind load calculation 
sheets for user load wind load patterns without any loading specified. This was an issue with the 
report generation only and did not affect results. 

 66348 An incident was resolved for shear wall design using the ACI 318-08, ACI 318-11, ACI 318-11 
Masonry, Mexican RCDF 2004 and NZS 3101-06 codes where, in the report table "Spandrel Shear 

Design", the fields labeled Vc, Vs and Vn were actually referring to φVc, φVs and φVn. The field 
labels have now been changed. Numerical results have not changed. This was a reporting issue and 
the design was unaffected. 

Database Tables 
Incidents Resolved 

* Incident Description 

* 56176 
60880 
62652 
63393 
64708 
65665  

An incident was resolved where, in certain cases, the table Story Drift could not be created. This 
also affected Report generation if this table was included. This was a reporting issue only and did 
not affect other results. 

 59890 An incident was resolved for shear wall design where the spandrel shear design report provided 
values of Avh and Avert even when spandrel was overstressed. Now the report will show "OS" 
instead indicating the overstressed condition. This is consistent with the "Shear Wall Spandrel 
Summary" table which shows no values for Avh and Avert when the spandrel is overstressed. This 
is just a reporting change and the results were unaffected. 

 61688 An incident was resolved in which the Shell Assignments - Property Modifiers database table was 
sometimes unable to be generated. This was a database table issue only and did not affect results. 

 62533 An incident was resolved in which some of the link definition database tables presented the data in 
incorrect columns. This affected the friction isolator, rubber isolator, and linear link definitions. 
This was a database table issue only and did not affect results. 

 63632 An incident was resolved in which the auto-seismic load pattern definition database tables were 
sometimes unable to be generated. This was a database table issue only and did not affect results. 

 66642 An incident was resolved where section property values (A, I33, etc.) were being displayed for 
nonprismatic sections in the Frame Sections table which did not apply to the actual section 
properties used in the nonprismatic section definition. These values are no longer shown for 
nonprismatic sections. This was a display issue and did not affect results. 

Data Files (.EDB, .E2K, .$ET) 
Incidents Resolved 

* Incident Description 

 61503 An incident was resolved where certain model files from ETABS version 9.7.4 and earlier could not 
be opened in ETABS 2013 versions 13.0.0 to 13.1.4 due to the presence of certain wall sections. 
The corresponding text files (.e2k and .$et) could be imported without error. This was not a 
common problem. 

* 65258 
65356 

An incident has been resolved where files saved in v13.1.2 could not be opened in the 64 bit version 
of v13.1.4. These files could still be opened in v13.1.3 and the 32 bit version of v13.1.4 and saved 
and reopened in the 64 bit version of v13.1.4 without loss of any data. 
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External Import/Export 
Incidents Resolved 

* Incident Description 

 61486 An incident was resolved where the following issues were corrected for export/import of text files:  
(1) Accidental eccentricity ratio was being set to the default value of 0.05 for Seismic type "User 
loads" when it was specified as zero.   
(2) Ω0, ρ and SDS factors were being reset to default values for ACI 318-11 concrete frame and 
shear wall design codes.   
(3) ρ and SDS factors were being reset to default values for ACI 318-08 concrete frame and shear 
wall design codes. 

 62489 An incident was resolved where some column/wall supports were not being exported from ETABS 
to SAFE. The error was obvious when the model was imported into SAFE. 

 63237 An incident was resolved for exporting slab/mat models to SAFE when a wall property name that 
included the inch (") symbol in ETABS needed to be exported. During the import into SAFE, an 
error message was given and the line representing the wall as a beam would end up without a 
property assigned. 

 65422 An incident was resolved where exporting and then importing models from text files with built-up 
steel sections modeled as Section Designer sections would lose the additional plates. 

 65945 An incident was resolved and enhancements added that address the following issues relating to the 
import of objects from 3D DXF files: 
(1) The elevations of AutoCAD "lightweight polyline" entities imported from DXF files into an 
existing model were not being converted for length units in the case where the DXF length units 
differed from those of the ETABS model. This did not affect the import of AutoCAD traditional 
polylines, nor did it affect any import operation initiated before a new model was started. When this 
error occurred, the error was obvious and the results agreed with the model as imported.  
(2) When importing a DXF file, ETABS generates story levels at the z-elevations at which it finds 
beams or horizontal slabs in the DXF file and presents the user with a Story Data form in which 
story levels can be added, renamed, moved and deleted. Previously, when no story level at elevation 
zero had been generated and the user tried to add one there, ETABS incorrectly issued an error 
message that the specified story elevation was too close to an existing story elevation and did not 
add the story level. Now this error message only displayed when relevant.  
(3) In some instances, after the user added a new story level below the lowest generated story level, 
two levels named Base were being created at two different elevations. Now ETABS only creates 
one story level named Base, always at the lowest story elevation.  
(4) In addition to generating story levels at the z-elevations at which it finds beams or horizontal 
slabs, ETABS now also generates a base story at the lowest z-elevation of all columns, walls, or 
other objects in the DXF file.  
(5) The user can now provide a story name as well as a story elevation when adding a story level. 
Previously, only the story elevation could be provided. 

 66728 An incident was resolved where models imported more than once from Revit Structure models or 
AutoCAD DXF files were creating duplicated grid systems with same name. No results were 
affected. 

Open Application Programming Interface 
Incidents Resolved 

* Incident Description 

 63892 An incident was resolved where API clients could "timeout" and lose their connection to the 
EtabsObject if no API calls were invoked for several minutes. 
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Documentation 
Incidents Resolved 

* Incident Description 

 60201 A documentation issue was resolved where the composite beam design manuals for the AISC 360-
05, AISC 360-10 and CSA S16-09 codes referred to a phi factor, phi_sc, as being available in the 
design preferences, when it isn't actually present. This factor is always taken as 1.0. 

 60758 An incident was resolved for Eurocode 2-2004 concrete frame design and shear wall design that 
addressed the following two issues: (1) For the Norway and Denmark National Annexes, the 
documentation showed factor k^(2/3) in Vmin, §6.2.2(1) and §11.6.1(1). The exponent of k should 
have been (3/2) instead of (2/3). The manuals have been updated accordingly. The design results 
were already correct. Only the manual was changed to agree with the design procedure. (2) For the 
Norway National Annex, §11.6.1(1) also has been changed from 0.030*k^(3/2)*(fck)^(1/2) to 
0.028*k^(3/2)*fck^(1/2) in accordance with corrigendum 2010. Both the manuals and the design 
procedure have been changed correspondingly, and the design results could change in the new 
version to reflect the new coefficient of 0.028. 

 61239 The steel frame design manual for IS 800:2007 has been updated for Amendment 1. This only 
updates the limiting width-thickness ratios for the compression element of "Double symmetric I-
Shape" sections for the "Flexure in Web" condition in Table 3-3. This is an update to the document 
only. Results were not affected. 

Miscellaneous 

* Incident Description 

 65446 The version number was changed to v13.1.5 for a new minor release.  

 

 


